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About This Guide
Purpose
This guide introduces Unisys Designer Workbench (DW) user operations. It
explains how you can use Designer Workbench to run your Unisys fourth
generation language (4GL) host systems MAPPER, LINC, and ALLY-from your PC workstation.

Scope
This guide includes the information you need to sign on to Designer
Workbench, start up host sessions, and perform basic Designer Workbench
utility tasks. It also describes some MAPPER, LINC, and ALLY system
functions specific to Designer Workbench users.
This guide does not cover all aspects of MAPPER, LINC, and ALLY system
operations: it is intended as a supplement to product-specific documents.

Audience
The audience for this guide is Unisys 4GL users who want to know how to
run their systems from a PC workstation equipped with Designer
Workbench. In this manual, the term user refers specifically to one of the
privilege levels that can be assigned when Designer Workbench is
configured. The Designer Workbench capabilities available at this privilege
level are described in this guide.
Activities of interest to administrators and developers (other types of
Designer Workbench users) are described in other documents. See "Related
Product Information" later in this section.
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Prerequisites
This guide assumes that Designer Workbench software has already been
installed and properly configured on your workstation, that your
workstation is connected to one or more 4GL host computers, and that your
4GL systems are fully operational.
You need to know your Designer Workbench user name and password in
order to sign on to Designer Workbench. Depending on how your system is
configured, you may also need to know host signon information before you
can begin a host session. If you did not install Designer Workbench yourself,
you must obtain Designer Workbench signon information from your
Designer Workbench administrator. Host signori information must come
from your MAPPER system coordinator, LINC system administrator, or
ALLY developer.
Other prerequisites include basic Windows skills and familiarity with
MAPPER, LINC, or ALLY operations.

Organization
This guide contains the following sections:
Section 1. Introduction offers a brief summary of Designer Workbench
and what it can do for the MAPPER or LINC user. It also describes
conventions and terms used in the manual.
Section 2. Running a MAPPER System describes basic procedures for
conducting sessions with a MAPPER host.
Section 3. Using the LINC Workbench explains the functions of the
LINC Workbench and how to conduct sessions with a LINC host.
Section 4. Running ALLY Applications explains how to run ALLY
applications from Designer Workbench.
Section 5. Managing Designer Workbench tells how to use Designer
Workbench facilities to alter your password, display user information, and
perform other system related tasks.
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Related Product Information
You may need to refer to one or more of the following Designer Workbench
manuals, depending on the tasks you will perform.
•

For managers and all Designer Workbench users:
Capabilities Overview — summarizes product capabilities and the
benefits of using Designer Workbench with Unisys 4GL systems.

•

For Designer Workbench software installers and site administrators:
Installation and Administration Guide — describes how to install
Designer Workbench software, configure communications facilities and
the Repository, and administer the system (including users, forms,
scripts, and other Repository objects).

•

For application developers:
Developer Training Guide — describes how to create forms with the
Forms Designer, specify MAPPER application run logic for forms
handling, and use the Forms Designer to customize the appearance of
LINC Ispecs.

•

For end users:
Operations Guide describes how to run host 4GL applications from
Designer Workbench and perform basic system-related tasks.

Online Product information

Each component of Designer Workbench also includes extensive online help
information accessed through a Windows-style help menu.
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Demonstration Disk and Video
Available by separate order are a Designer Workbench demonstration
diskette and a videotape:
•

Introduction to Designer Workbench (78319829-000)— a PC
demonstration program that introduces Designer Workbench
capabilities.

•

Designer Workbench: Bring 4GL Power to Your PC (7831 9837°00)— a VHS video that presents Designer Workbench and highlights
product benefits.
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Section 1
Introduction
Section 1 introduces Unisys Designer Workbench and describes the terms
and conventions you will encounter throughout this manual.
This section includes the following topics:
Introduction to Designer Workbench
•

Before you begin
Where to start

If you are comfortable working in the Windows environment and are eager
to see how Designer Workbench works, you may wish to skip directly to
Section 2 (MAPPER), Section 3 (LINC), or Section 4 (ALLY). On page 2 of
each of those sections is a brief guide to starting up a session with your host
4GL system. Feel free to explore the command menus and use the contextsensitive help system to find out about Designer Workbench function&
If you finish reading this section first, you will learn more about this guide
and how to get started using your Designer Workbench system.

7831
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Introduction to DW

Introduction to Designer Workbench
Designer Workbench is a PC-based product that enhances the use of your
Unisys 4GL systems. With Designer Workbench, you can
•

Run host-resident MAPPER, LINC, and ALLY applications from
Windows — an industry-standard GUI (graphical user interface)
environment

•

Access any 4GL system running on any host computer in a supported
configuration without loading separate terminal emulators or additional
communications software

•

Run your existing 4GL applications without rewriting (unaltered
MAPPER applications run in native character mode)

•

Run your MAPPER applications using graphical forms (screen layouts)
especially created for Designer Workbench

•

Run your LINC system using Ispecs customized with the Designer
Workbench Forms Designer.

•

Access Windows-style help for all Designer Workbench operations

For more information about Designer Workbench features, see the Designer
Workbench Capabilities Overview.

1-2
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Before You Begin
If you are new to the Windows environment, you may wish to spend some
time familiarizing yourself with general Windows terms and concepts. The
Microsoft Windows User's Guide contains much helpful information that
applies to all Windows applications— using the mouse, working with icons,
getting help, and so on.
This guide follows Windows terminology and procedures wherever possible.
MAPPER, LINC, and ALLY conventions are used in cases where functions
unique to those systems are discussed. Please refer to your MAPPER,
LINC, or ALLY documents for this information.
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Where to Start
If you are a 4GL user who is switching to Designer Workbench from PC
terminal emulator software or another kind of terminal, your host system
user name and password probably will not change.
However, you must also have a separate user name and password to sign on
to Designer Workbench before you can use any of its facilities. At first this
may sound like a serious inconvenience, but it is the key to the ability of
Designer Workbench to maintain system security while allowing you to
switch among host sessions without signing on over and over again. See
"Working with Scripts" in Section 4 of this manual for more information
about host sign-on options.
Your Designer Workbench administrator can supply you with user and
password information you need to run Designer Workbench. Your Designer
Workbench administrator should also provide the name of the script or
scripts you need to connect to your host 4GL systems once Designer
Workbench is up and running.
Note: In this guide, Designer Workbench administrator refers to the person
who installed and/or configured Designer Workbench on your PC. The
MAPPER coordinator and the LZNC System administrator are the
people responsible for configuring the host MAPPER or LINO system
you work with.
Use the following procedure to run Designer Workbench from the Windows
Program Manager (this information is repeated in Sections 2 and 3):
1. Double-click the Designer Workbench icon in the Designer Workbench
group window.
The sign-on window appears.

1-4
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and choose
2. Type your user ID aid ac rd t e eld nd
Enter.
on bolt your Designer Workbench system is
ea
What happens
configured:
•

Ur= have access to more than one partition and have not been
assigned a default partition, the Select Partition dialog box appears.
Select, e, partition in the list box and choose OK to continue. (See the
Thrianatimg Designer Workbench" section of this guide for more
information about selecting partitions.)

•

If you have access to a single partition or you have been assigned a
default partition, you will not be required to select a partition.

The main Designer Workbench window appears.

Pi Vac i I it looms

This window contains the Designer Workbench facility icons, including the
MAPPER, LILAC, and ALLY.icons you use to start up your host 4GL
sessions.
7831 9779-000
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If you are ready to begin a host 4GL session, you may proceed to Section 2
(MAPPER), Section 3 (LILAC), or Section 4 (ALLY). If you want to explore
other Designer Workbench facilities, go to Section 5.

1-6
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Section 2
Running a MAPPER System
Section 2 describes how to use Designer Workbench to run a MAPPER
system.
This section includes the following topics:
•

Starting up a MAPPER session

•

Using MAPGRAPH

•

Using Pictures

7831 9779-000
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Starting

Starting up a MAPPER Session
The following steps describe the proceduxe for starting Designer Workbench
and connecting to a MAPPER system. Working with MAPPER runs and
other MAPPER activities are discussed in later paragraphs.
1. Double-click the Designer Workbench icon in the Windows Program
Manager.
The sign-on window appears.
2. Type your user ID and password in the fields indicated and choose
Enter.
What happens next depends on how your Designer Workbench system is
configured:
•

If you have access to more than one partition and have not been
assigned a default partition, the Select Partition dialog box appears.
Select a partition in the list box and choose OK to continue. (See the
"Managing Designer Workbench" section of this guide for more
information about choosing partitions.)

•

If you have access to a single partition or you have been assigned a
default partition, you will not be required to select a partition.

The Designer Workbench window appears.
3. Double-click the MAPPER icon.
The MAPPER Window and the MAPPER Profiles dialog box appear.
[This box title should be changed to comply with agreed vocabulary.)
4. Select the MAPPER system you want to connect to and choose OK to
continue.
(Are there any progress messages? What happens when the connection
is established?)

2-2
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[Need graphic of MAPPER window.]
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Using MAPGRAPH
MAPGRAPH is a Designer Workbench facility that displays the results of
MAPPER graphics runs. When you create a chart or graph during a
MAPPER host session, it is automatically displayed in the MAPGRAPH
window. You can use the regular MAPPER window to view graphics run
code while simultaneously viewing the results in the MAPGRAPH window.
tiaporeph

1:115
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If you have a printer attached to your PC, you can print MAPPER graphics
directly from MAPGRAPH. You can also save the code for any displayed
graphic to a local file for viewing or printing at some other time. You do not
need to be in session with a MAPPER host to open local MAPGRAPH files.
For more information about using MAPPER graphics runs and
MAPGRAPH, see the MAPPER System Color Graphics Operations Guide.

2-4
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Using Pictures
Pictures is a Designer Workbench facility called by the MAPPER and LINC
APIs to display graphics used by MAPPER runs or LINC Ispecs. This
process is internal, and Designer Workbench automatically opens and closes
the Pictures window as needed.
You can also open Pictures manually in order to display graphics files stored
in several different formats:
•

BMP

•

DIB

•

PCC

•

PCX

•

RLE

Designer Workbench developers can use this capability to preview graphics
they may want to use with the Forms Designer.

7831 9779-000
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Section 3
Using the LINC Workbench
Section 3 describes how to use Designer Workbench to run your LINC
System.
This section includes the following topics:
•

Starting up a LINC session

•

Using Keystroke commands

•

Working with Ispecs
•

Selecting an Ispec

•

Managing multiple Ispecs

•

Completing an Ispec transaction

• Viewing Teach screens
•

Dealing with messages and errors

Entering a colon command
•

Running a Report

•

Changing the language in which the LINC System is running

•

Closing a LII session

StartingUNC

Starting up a LINC Session
All LINC System activities are performed in a Designer Workbench window
called the LINC Workbench (see the figure on the facing page). Since the
LINC Workbench icon is displayed in the main Designer Workbench
window, you must sign on to Designer Workbench before you can run the
LINC Workbench.
The following steps describe the procedure for starting Designer Workbench,
connecting to a LINC system, and displaying an initial 'spec. Working with
Ispecs and other LINC Workbench activities are discussed in later
paragraphs.
1. Double-click the Designer Workbench icon in the Windows Program
Manager.
The sign-on window appears.
2. Type your user ID and password in the fields indicated and choose
Enter.
What happens next depends on how your Designer Workbench system is
configured:
•

If you have access to more than one partition and have not been
assigned a default partition, the Select Partition dialog box appears.
Select a partition in the list box and choose OK to continue. (See the
"Managing Designer Workbench" section of this guide for more
information about selecting partitions.)

•

If you have access to a single partition or you have been assigned a
default partition, you will not be required to select a partition.

The Designer Workbench window appears.
. Double-click the LINC Workbench icon.
The Background Window of the LINC Workbench appears.
4. Choose Open Session from the File menu.
The LINC Systems dialog box appears.

Starting UNC

5. Select the LINC system you want to connect to and choose OK
While the connection is being established, the message Connecting to
Host appears on the status line at the bottom of the LINC Workbench
window.
When the connection is established, the name of the LINC System
appears on the title bar of the LINC Workbench window and the
message Workbench is Online appears on the status line.
If the host LINC System has a Fireup Ispec, that Ispec appears
automatically.
6. (Optional) If no Fireup Ispec exists, the Ispec Selection dialog box
appears and you may select the initial Ispec with which to work.
When an Ispec is displayed, the message INPUT REQUEST appears on
the status line indicating the LINC System is awaiting input.

Run
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Using Keyboard Commands

Using Keyboard Commands
Commands on the LINC menu can be invoked directly from the keyboard as
well as from the menu bar using the mouse.
Where specific procedures are outlined in this section, only the steps for
using the mouse are listed. You may substitute keyboard commands for any
of the functions in the following table:

Table 4-1. LINC Menu Command Keys

Key
Ctri-I
Ctrl-C
Ctrl-R
Ctrl-T
Ctrl-M
Ctri-L.
Ctrl-E
Ct$.S

Function
Select !spec
Colon Cimmand
Run Report
View Teach Screen
View Messages/Errors
Select Language
Clear Transaction
Show pacus Line

Working with lspecs

Working with !specs
When using the LINC Workbench to work with Ispecs, you may perform
some or all of the following activities:
•

Selecting an Ispec

•

Managing multiple Ispecs

•

Completing an Ispec transaction

•

Viewing Teach screens

•

Dealing with messages and errors

Selecting an Ispec
When Designer Workbench establishes a connection to the LINC System
you have selected, either the Fireup Ispec or the Ispec Selection dialog box
appears.
At any time during a session, you can return to the Ispec Selection dialog
box to select a new Ispec by Choosing Select Ispec from the LINC menu (see
the following figure).
[Show Select Ispec dialog box.)

Use the following procedure to select an Ispec using the Ispec Selection
eialog box:
I. Select an Ispec from the list of available Ispecs. If necessary, you can
use the scroll bar to display additional portions of the list. Only Ispecs

Working rrith Ispecs

to which you have been granted access by your Designer Workbench
Administrator are displayed.
Alternatively you can enter an Ispec name directly in the Ispec Name
edit box.
. Select the New Window check box if you want the Ispec you are selecting
to appear in a new window. When the New Window option is set,
previously selected Ispecs remain open, but inactive, when a new Ispec
is selected.
If you want the new Ispec to replace the current one, make certain the
New Window check box is empty.
Choose OK.
The selected Ispec is displayed.

Managing Multiple !specs
When you are working with multiple Ispecs, only one Ispec window can be
active at a time. You can use the Option and Window menus to control how
inactive 'specs are displayed and to help you switch between them:
•

Choosing Minimise on Change from the Option menu causes the
currently active Ispec window to shrink to an icon when you open a new
Ispec window.
You can return to an inactive Ispec by double-clicking the appropriate
icon. The previously active Ispec window shrinks to an icon.
Minimise on Change remains in effect until you choose it again,
removing the check mark that appears beside it.
When Minimise on Change is not in effect, inactive windows remain
open but are positioned behind the active window. You can make all the
open Ispec windows visible by selecting Tile or Cascade from the
Window menu. You can also use the mouse to move and/or change the
size of Ispec windows so you can see more than one Ispec at a time.
Clicking on any portion of an inactive !spec window causes that window
to become active.

Working with !specs

(Show graphic of cascaded Ispec windows.]

•

Choosing the Window menu displays a list of open Ispecs. Choosing an
Ispec name from the list causes that Ispec window to become active.

Completing an !spec Transaction
To send a transaction using an Ispec window:
1. Fill in the fields in the Ispec window as appropriate.
Your LINC System administrator can supply details of valid entries. If
your LINC System includes them, you can also view Teach screens for
particular !specs See "Viewing Teach Information for an Ispec" later in
this section.
2. Press the ENTER key to send the transaction to the host LINC System.
(The Clear Transaction command is not described anywhere in this section.
If you use this command to clear the fields you may have entered in an
Ispec, the command should be documented here. Need more info.]
None of the information you fill in is sent to the host until you press the
ENTER key. This means you can make entries in fields in any order, and
you can go back to edit the entries if required.
Viewing Teach Screens
If your LINC System includes Teach screens, you can use the following
procedure to view one or more Teach screens of help information for a
particular Ispec:

Working with !specs

I. Choose View Teach Screen from the LINC menu.
2. Choose an Ispec name in the Ispecs list box.
The names of the Teach screens associated with the Ispec appear in the
Teach Screen list box.
3. Select a Teach screen name in the Teach Screen list box.
4. Choose OK.
[Show a graphic of the Teach screen dialog box.)

Dealing with Messages and Errors
Single messages from the LINC System or the LINC Workbench are
displayed on the status line of the LINC Workbench window. For example,
if there is an incorrect entry in an Ispec field when you send a transaction to
the LINC System, the host will return an error message to help you locate
and correct the entry.
The host may also return multiple messages, as when, for example, several
Ispec fields contain errors when a transaction is sent to the LINC System.
In this case, the message Multiple Messages - see Messages /Errors dialog is
displayed on the status line.
When you see this message, you can use the following procedure to view the
multiple messages:
1. Choose View Messages/Errors from the LINC menu.

Working with !specs

The messages are displayed.
2. Choose OK when you are finished viewing messages.
The View Messages/Errors dialog box is displayed automatically when you
run a Report or enter a colon command.
(Show a graphic of the Messages/Errors dialog box.)

No e: The View Messages 'Errors dialog box may be displayed continuously
if required. New messages are displayed when received.

You can turn the status line on and off by choosing Show Status Line from
the EIC menu. It is recommended that you leave the status line displayed
to aid in your interaction with the LBW System.

Entering a Colon Command

Entering a Colon Command
[It would be nice to have a brief explanation of what these commands are.)
You can use the following procedure to send a colon command:
I. Choose Colon Command from the LILAC menu.
The Colon Command dialog box appears.
[Show a graphic of the Colon command dialog box.]

2. Select a colon command from the list of available names. If necessary,
you can use the scroll bar to display additional portions of thelist.
Alternatively, you can enter a colon command and parameters directly
in the Command Name edit box.
[I have rewritten this description to include the list box procedure on the
basis of notes I made when Graeme was here. We must confirm this
when we get into the lab.]
3. Choose OK to send the command.
The View Messages/Errors dialog box appears to allow you to view
messages returned by the colon command.

Running a Report

Running a Report
Running a LINC Report consists of three steps:
1. Starting the Report.
2. Replying to any messages.
3. Obtaining any output.
These steps are described below in more detail.

Starting the Report
To start a Report:
1. Choose Run Report from the LINC menu.
The Report dialog box appears.
[Show a graphic of the Report dialog box.]

2. Select a Report from the list of available Reports. If necessary, you can
use the scroll bar to display additional portions of the list.
Alternatively, you can enter a Report name directly in the Report Name
edit box.
3. Append the appropriate device to the name in the Report Name edit
box.
[Is this the name of an output device? Does the user have to ask the
LINC administrator for this name? Is there a list somewhere? Is there
a default? We need more info here.]

Running a Report

. Choose OK

Replying to Messages from a Report
The View Messages/Errors dialog box appears if the Report sends messages
and asks for replies (see "Dealing with Messages and Errors" above). The
messages are displayed in a list box. The Response edit box is for your
reply:
3.. Enter your reply in the Response edit box.
2. Choose Send to send the LINC System.
3. Choose Cancel to exit from the View Messages/Errors dialog box when
you are finished.

Obtaining the Output
Your LINC administrator will
Report.

I you how to obtain the output from a

Changing the Language

Changing the Language
If alternative languages have been defined for your LINC System, you can
change the language in which 'specs, Teach screens, and messages are
displayed.
Use the following procedure to change the language in which the LINC
System is running;
1. Choose Select Language from the LINC menu.
[Show graphic.]

2. Select the required language from the Languages list box.
3. Choose OK.
Subsequent interactions with the LINC System will be in the new language.

'011 157711_finii

Closing a UNC Session

Closing a LINC Session
When you have finished using a LINC System, you must terminate the
connection to the LINC host:
1. Choose Close Session from the File menu.
The message Terminating Host connection appears on the status line.
Caution
The File Close Session command must be used to terminate the
Designer Workbench connection to a LINC System. Do not use the BYE
command from a LINC System.
2. To connect to another LINC System, choose Open Session from the File
menu.
To exit from the LINC Workbench, choose Exit from the File menu.

Section 4
Running ALLY Applications
Section 4 describes how to use Designer Workbench to run your ALLY
applications.
This section includes the following topics:
•

To be completed

•

7831 9779-000
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Section 5
Managing Designer Workbench
Section 5 tells how to use Designer Workbench facilities to alter your
password, display user information, and perform other system related tasks,
This section includes the following topics:
Changing your password
Working with partitions
•

Working with scripts
Working with Session Notes

•

Displaying Repository information

•

Exporting and Importing Repository objects

Changing Your Password

Changing Your Password
Unless you installed Designer Workbench yourself, you need to get your
user name and initial password from the Designer Workbench
administrator. Once you have signed on to Designer Workbench using the
assigned password, you may change your password whenever you like.
Your password can be from 1 to ? characters long. Passwords (and user
names, as well) are case sensitive. That means upper and lower case letters
cannot be used interchangeably; for example, Designer Workbench treats
"Secret" and "secret" as two different words.
II typed in 24 characters before the machine beeped at me. Does this mean
passwords can be 24 characters long? If there are other limitations on what
characters can be used, we need to mention those too.)
Use the following procedure to change your Designer Workbench password:
1. Choose Change Password from the User menu.
The Change Password dialog box appears.
2. Type the new password in the New Password field
3. Move the cursor to the Confirmation field using the mouse or the Tab
key.
4. Type your new password agam, being careful to enter it exactly as you
did in the previous field.

v.

Choose OK.
If the New Password and Confirmation fields match, your new password
is accepted and it will be in effect the next time you sign on to Designer
Workbench. If they do not match, a message box will appear and you
will get a chance to start over.

Note: This password is for signing on to Designer Workbench only.
Changing your Designer Workbench password does not affect any
passwords that may be required by your host 4GL systems.

5-2
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Working with Partitions
Every time you start up a session with Designer Workbench, that session
takes place in a particular Repository partition. Partitions are like
directories the Designer Workbench Repository uses to manage its objects
and to keep track of activities that take place during the session.
If your Designer Workbench administrator has assigned you a single
partition or has set a default partition for you, that partition is selected
automatically when you sign on to Designer Workbench.
If the administrator has made more than one partition available to you, you
must select a partition to work with when you sign on. The partition you
select may be significant in cases like these:
•

If you intend to import Repository objects during a session. Certain
kinds of objects, such as forms and graphics files, are associated with a
single partition. If a developer or your Designer Workbench
administrator has given you a file of objects to import into a partition,
you must select that partition when you begin your Designer Workbench
session.

•

If you have more than one privilege level. You have been assigned a
privilege level (visitor, user, developer, or administrator) for each of the
partitions you have been given access to by the Designer Workbench
administrator. If you have different privilege levels in different
partitions, you will want to select a partition that permits you to
perform the activity you have planned during a session. For example, if
you have developer privileges in partition A and user privileges in
partition B, you cannot use the Forms Designer unless you select
partition A when you sign on to Designer Workbench.

For more information about Repository partitions and privilege levels, see
the Designer Workbench Capabilities Overview.
Note: The name of the partition you have selected appears in parentheses in
the title bar of the main Designer Workbench window.
The following paragraphs discuss the prwedures for displaying partition
access and privilege information and for setting a default partition.

Vie raring Partition Information

7831 9779-000
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Use the following procedure to find out which partitions are available to you
and what your privilege level is in each.
1. Choose Partition Information from the User menu.
The Partition Information dialog box appears. The names of the
partitions available to you appear in the list box.
2. Select a partition name from the list box.
Your privilege level for the chosen partition appears following the
Privilege Level field.
3. Choose OK to exit the Partition Information dialog box.
Contact your Designer Workbench administrator if you need access to
another partition or if you need your privilege levels changed.
Setting a Default Partition

If more than one partition is available to you, you must choose the one you
will work with during a session. You can choose a partition at sign-on time,
or you can set a default partition that will be selected automatically every
time you sign on to Designer Workbench.
If you set a default partition, your choice remains in effect for all future
sessions until you clear it or until you select a different default partition.
Use the following procedure to set or alter a default partition.
1. Choose Partition Information from the User menu.
The Partition Information dialog box appears.

2. Select a partition name from the list box.
3. Choose Set.
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The name of the partition you have chosen appears in the Default
Partition field.
4. Choose OK to exit the Partition Information dialog box.
To clear the default partition without setting another one, do the following:
1. Choose Partition Information from the User menu.
The Partition Information dialog box appears.
2. Choose Clear to remove the default partition name.
3. Choose OK to exit the Partition Information dialog box.
Note: if you want to work with a partition other than your current default
partition, you must follow the above procedure to clear or reset the
default partition and then exit and sign on to Designer Workbench
again. You cannot change the working partition during a session.
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Working with Scripts
When your Designer Workbench software was installed, the Designer
Workbench administrator configured scripts for you to use to connect to your
host 4GL systems. These scripts contain path and protocol information
necessary to establish communications between your PC and the host
system you want to work with. You must have at least one script for every
host 4GL system available to you.
Sections 2 and 3 of this guide describe how to choose a script when starting
up your host 4GL session. The paragraphs that follow explain how to find
out which scripts are available to you and how customized scripts can help
you make the most effective use of your Designer Workbench system.

Viewing Profile Information
(This heading comes from the name of the command that displays the User
Scripts dialog box. We have to get our vocabulary straightened out.)
Use the following procedure to view the list of scripts available to you:
1. Choose Profile Information from the User menu.
The User Scripts dialog box appears. All the scripts you may use are
shown in the list.
2. Choose OK to exit the User Scripts dialog box.
If you need help deciding which scripts are for which systems or in having
new scripts added to your list, contact your Designer Workbench
administrator.

Customizing Scripts and Icons
User scripts can be tailored to include specific host sign-on information and
even, in the case of MAPPER, the name of a run to be executed when the
host session begins. Your Designer Workbench administrator will tell you
whether customized scripts are available for the applications and/or systems
you need to use.
If you are familiar with the Windows Program Manager, you may wish to
try creating program item icons for particular MAPPER and LINC scripts.
For example, if you have scripts for your most frequently used MAPPER
applications, you can create individual icons that will let you start up
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Designer Workbench and run those applications directly from the Designer
Workbench group window. If your scripts include host sign-on information,
you can switch from one host to another without signing on again each time
you start up a new session. You must, however, sign on to Designer
Workbench once when you begin.
If you think you need new scripts to help you make the best use of this
capability, discuss it with your Designer Workbench administrator. The
administrator must prepare and assign any new To create an icon for a MAPPER or LINC script, follow the procedures in the
Microsoft Windows User's Guide for adding program items and documents to
a group. When you get to the Command Line field in the Program Item
Properties dialog box,. fill in the following information:
•

(For MAPPER) c : 1dvninapper axe -esc r ipt, where script is the
name of the MAPPER script you want to run when you double-click the
icon.

•

(For LINC) c chr1 I i nc .exe scr ipt, where s cript is the name of the
LINC script you want to run when you double-click the icon.

[We need to verify the path that results from the standard Designer
Workbench installation.]
Note: Some host systems requwe that yrs periodically change passwords.
If you change a host system password for any reason, scripts that
include this information will not run properly until you have them
modified by the Designer Workbench administrator.
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Working with Session Notes
The Session Notes facility gives you a way to make a permanent record of
your activities or other information associated with a Designer Workbench
session. The text you enter with Session Notes is stored along with your
user name and the time of the session, and all this information can be
viewed later by you or others authorized to use your Designer Workbench
system.
The following subsections describe how to record and display Session Notes.
Recording Session Notes
Use the following procedure to run the Designer Workbench Session Notes
facility:
1. Double-click the Session Notes icon in the Designer Workbench window.
The Session Notes window appears (see the following figure).

The line under the title bar displays the time the session began, your
user name, and the date. This information is recorded along with your
notes and can help you identify sessions later.
2. Type any text you wish in the Session Notes workspace.
3. When you are finished typing, click the Minimize button.
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You cannot actually Close the Session Notes facility unless you exit
Designer Workbench completely. You may return to Session Notes to add or
edit material at any time until you end your Designer Workbench session.
Displaying Session Notes
You can view notes you or other users recorded in previous sessions by
following this procedure:
1. Choose Display Sessions from the Database Menu.
The Sessions List dialog box is displayed. Sessions are identified by
date, time, and user name and are listed in chronological order. The last
session on the list (your current session) is highlighted.
2. Select a session, scrolling up through the list to find earlier sessions if
necessary.
3. Choose OK to display the Session Detail dialog box.
This window shows who conducted the session, when the session began
and ended, and any notes recorded by the user (see the following figure).
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4. Choose OK to return to the Session List dialog box.
5. You can select another session,or you can choose Cancel to exit the
Sessions List dialog box.
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Displaying Repository information
You can display information about the amount of disk space the Repository
is using and the amount of disk space that remains by choosing About from
the Help menu (see the following figure).

Unisys Repository
UREP!P$W
Version: Beta 1.4
Database Level: 1
Copyright 0 1990 Unisys Corp.

User. John
Repository: Bele 1.4 Release
Partition: User
Repository space used:
Disk space remaining:
Lest bedasp: Tuesday. January
3:08PM
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Exporting and Importing
Export and import are two halves of the process for transferring objects from
one Designer Workbench Repository to another or from one partition to
another within the same Repository. Most exporting and importing is done •
by the Designer Workbench administrator, and you do not need to know how
to do this in order to use Designer Workbench properly.
The following paragraphs outline the procedures for exporting and
importing certain kinds of Repository objects and provide some suggestions
as to why you might want to do this.

Exporting Objects
The classes of objects that ers can export include partitions, users, and
various kinds of scripts.
Partition is a class of objects that includes other Repository objects such as
forms and graphics files. When you export a partition, you also export the
objects associated with that partition. You could use this capability to share
updated or customized forms with another Designer Workbench workstation
by exporting the entire partition used by a MAPPER or LINC host system.
If you are interested only in particular forms or other objects within a
partition, your Designer Workbench administrator can export selected
objects for you.
The user class is similar to the partition class in that it encompasses various
other classes of objects. When you export a user, you also export forms,
scripts, and other objects associated with that user. As explained in the
previous paragraph, you could export a user in order to share updated or
customized forms with another Designer Workbench workstation, but again
your Designer Workbench administrator can do this for you with less
likelihood that you will end up with a lot a objects you do not need or want
in the wrong partitions of your Repository.
Scripts include different classes of scripts for making connections to
MAPPER and LINC host systems. You might want to share scripts with
other Designer Workbench users by exporting them from one Repository to
another. However, you will have to depend on the Designer Workbench
administrator to assign script access in the receiving Repository and to do
any editing that might be required to tailor the scripts to another user's
configuration.

7831
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Use the following procedures to export Repository objects.
1. Choose Export from the Database menu.
The Export Selection dialog box appears.
2. Click the arrow on the Class box to display a list of classes.
3. Choose a class by highlighting the one you want.
A list of objects in the class you have chosen appears in the Objects
Available box.
4. Select the object you want in the Objects Available box and choose Add.
The name of the object you have chosen appears in the Objects Selected
box.
Repeat step 4 to add more objects. If you change your mind, you can
remove an object from the Objects Selected box by highlighting the name
and then choosing Remove.
5. When the names of all the objects you want appear in the Objects
Selected box, choose OK to continue.
The Transport Progress dialog box appears briefly, followed by the
Export: Open Media dialog box.
6. Enter the name you want to assign to the file that will contain the
exported objects in the filename box (all export files get an extension of
TO1). You may direct this file to any drive on your workstation,
including a floppy disk.
7. Choose OK to create the export file.

Importing Objects
You can import any file created by a Repository export operation. When you
import objects, the potential for conflict exists because of duplicate object
names. If you try to import an object with the same name as an object
already in the Repository (even if it is simply another version of the same
object), the Repository pauses to allow you to resolve conflicts by renaming
objects or specifying whether older or newer version should take precedence.
Use the following procedure to import Repository objects.
1. Choose Import from the Database menu.
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The Import: Open Media dialog box appears.
2. Type the name of the file you want to import, including path information
if necessary (note the TO? extension).
Once you have entered the import file name, you may optionally display
information about the file by choosing Information. This displays the
Transport, Media Label box, which shows the size of the file, the number
of objects it contains, the user who created it, and so on.
. Choose OK to proceed with the import,.
The Transport Progress dialog box appears.
4. Look at the name in the Transport Progress dialog box to confirm that
you have selected the file you want, then choose OK to proceed.
The objects in the file are imported. You will be prompted if the file you
are importing contains any objects already in your Repository.
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active
(U) A window or icon that is selected; the window or icon to which the next
keystroke or command will apply.
administrator
(1) A person responsible for configuring and maintaining system software
and hardware. (2) One of the four privilege levels assigned to Designer
Workbench users. See also visitor, user, developer.
ALLY
CP) A Unisys fourth generation language (4GL).
API (application programming interface)
[eed definition.]
application
In this manual, application refers to any implementation of a Unisys 4GL
system used to perform particular tasks for users.
application 1C031
CM) A graphical representation of a running application that has been
minimized. Application icons appear on the desktop.

bitmap
(I) (M) An image stored as an array of bits. (2) A bitmapped image in a
particular format (.B1 P).

check box
CU) A small square box with related text that appears in a dialog box. Check
boxes represent choices that can be turned on or off.
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class
(P) A Repository term for a collection of objects with common attribute
types.
click
(U) To press and release a mouse button quickly,
colon command
A command used to communicate directly with the controlling LINC System
software at run time. Also called a LINC System command.
mand
(U) A word or phrase, usually found in a menu, that you choose in order to
carry out an action.
command button
(U) A large rectangular button that appears in a window and carries out or
cancels an action when chosen. For example, the Cancel button always
cancels the command. The OK button carries out the command.
Occasionally, the button that carries out the action has a label that describes
the action —for example, Open.
context-sensitive help
(P) Help relevant to a particular area on the screen or user action in
progress when help was invoked.

developer
(1) A person who creates an application. (2) One of the four privilege levels
assigned to Designer Workbench users (associated with Forms Designer
privileges). See also visitor, user, administrator,

dialog box
(U) A rectangular box that appears when the program needs more
information before it can carry out a command or when the program
providing you with certain information.

F
form
A graphical screen layout used run a 4GL application within the Windows
environment
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Forms Designer
Designer Workbench component that functions as an interactive formsdesign tool.
fourth generation language (4GL)
Any of the high level computer languages, frequently offering ready-made
tools, predefined data structures, and a simplified command syntax, created
to reduce the time and effort required to design, develop, and maintain
applications.

GUI (graphical user interface)
General term for software environments that include a graphically oriented
shell through which users interact with applications. Windows is one such
system.

H
hos
(P) For Designer Workbench, an 1100, A Series, or U Series computer
executing MAPPER, LINC, or ALLY software.

loon
(U) A graphical representation of an element in Windows, such as a disk
drive, application, or document. You can manipulate the icon to perform
various actions on the element, such as starting an application or copying a
file.
INFOConnect
(P) The software that handles PC-to-host communications for Designer
Workbench.
Ispec
(1) A collective term for components and events in a LINC System. (2) A
contraction of the term interface specification.
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LiNc
A Unisys fourth generation language (4GL .
list boz
(U) A box within a dialog box that lists all the items a command could affect.

MAPPER
A Unisys fourth generation language (4GL).
menu
(U) A list of available Windows or application commands. Menu names
appear in the menu bar near the top of a window.
menu bar
CU) The horizontal bar that lists the names of an application's menus. The
menu bar appears below the title bar of a window.

0
object
(P) A Repository term for an instance of a class with a unique identity in the
system.
option button
CU) A small round button that appears in a dialog box and selects an option
when set. Within a group of related option buttons, you can select only one
option at a time.

R
Repository
Designer Workbench component that stores and manages system objects.
A series of instructions that a MAPPER system interprets to produce a
report or perform other tasks such as updating reports.

S
script
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A Repository object that contains information used by the system when
establishing a connection between Designer Workbench and a host.

teach screen
A user-written screen display of information about an Ispec being used
within a LINC Information System.
text box
A box in a dialog box in which you type information the system needs to
carry out a command,
title bar
The horizontal bar across the top of each window that contains the name of
the window and/or the file in the window.

U
user
(1) Anyone who uses Designer Workbench. (2) One of the four privilege
levels assigned to Designer Workbench users. See also visitor, developer,
administrator.

visitor
One of the four privilege levels assigned to Designer Workbench users. See
also programmer, developer, administrator.

workstation
For Designer Workbench, a properly configured 80286 or hi er personal
computer.
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